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Preface

This guide provides step-by-step procedures to help you install, deinstall, and upgrade Oracle Fail Safe.


Audience

This document is intended for anyone who must perform the initial setup and installation of Oracle Fail Safe on Microsoft Windows systems.

In general, this book defines technical terms and concepts when they are introduced. However, it assumes that you know the underlying operating system and are familiar with basic system administration tasks. Also, you should be familiar with Microsoft Cluster Server (MSCS).


Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible to all users, including users that are disabled. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.


Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.


Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.


Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues and provide customer support according to the Oracle service request process. Information about TRS is available at http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.


Related Documents

For more information, see the following documents in the Oracle Fail Safe documentation set:

	
Oracle Fail Safe Release Notes


	
Oracle Fail Safe Concepts and Administration Guide


	
Oracle Services for MSCS Error Messages


	
For online assistance, Oracle Fail Safe Manager provides a tutorial and online help topics. To access the tutorial and online help topics, click Help on the menu bar of the main Oracle Fail Safe Manager window.




For information about related products, refer to the following documentation:

	
For more information about cluster systems, see the Microsoft Cluster Server (MSCS) documentation.


	
For more information about other related products, see the documentation for those products.





Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.
	italic	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.
	monospace	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.







1 Introduction and Preinstallation Checklist

This guide uses a step-by-step approach to assist you with the installation of Oracle Fail Safe. Oracle Fail Safe consists of multiple components: Oracle Fail Safe Manager, Oracle Services for MSCS, and server components specific to Oracle Fail Safe.

Oracle Fail Safe Manager is a graphical user interface using which you configure and manage Oracle single-instance databases, Oracle Management Agent, generic services, and so on for high availability in an MSCS cluster. Oracle Services for MSCS is the main server component.

Typically, you perform the installation using Oracle Universal Installer graphical user interface. If you perform the same installation on multiple systems, you may run Oracle Universal Installer in silent mode to automate the installation process in batch files or scripts. Silent installations are described in Appendix B.

The following topics are discussed in this chapter:

	
Cluster Setup Prerequisites


	
Software Compatibility


	
Recommended Order for Software Installation


	
Adding a Node to an Existing Cluster


	
Adding a Sample Database


	
Postinstallation Procedures






1.1 Cluster Setup Prerequisites

You must perform the following configuration tasks before the installation of Oracle Fail Safe:

	
Ensure that you have a cluster hardware configuration listed on the Microsoft hardware compatibility list for Microsoft Windows clusters.


	
Ensure that each system supports TCP/IP.


	
Check that each system has the proper Oracle Net tnsnames.ora configuration to allow the system to connect to its local database (if applicable) and the databases on the other systems.


	
If you install Oracle Services for MSCS on a subset of the nodes in the cluster, check that the Cluster Group is running on one of the nodes where you installed Oracle Fail Safe. You can view or change the location of the Cluster Group using MSCS Cluster Administrator.


	
Ensure that Microsoft Windows Event Viewer is not running while installing Oracle Services for MSCS. This is an issue only if installing on top of an existing installation (in-place upgrade).




	
Note:

If you attempt to install Oracle Services for MSCS while the Microsoft Windows Event Viewer is running, the installation procedure may return an error indicating that it cannot copy the fsus.dll file (fsja.dll on Japanese systems) and asks you to retry, ignore, or cancel. You can continue the installation if you stop the Microsoft Windows Event Viewer and then click Retry in the Oracle Fail Safe installation Error window.















1.2 Software Compatibility

Refer to Oracle Fail Safe Release Notes for information on current software compatibility for different operating systems.






1.3 Recommended Order for Software Installation

Although this guide describes the Oracle Fail Safe installation in detail, other products must also be installed to implement the Oracle Fail Safe environment. Figure 1-1 shows the recommended order for installing software on a two-node cluster




	
Note:

(The numbers in Figure 1-1 do not correspond to the numbered steps in the subsequent list because the list contains more detailed information than the figure.








Figure 1-1 Recommended Order for Installing Software on a Two-Node Cluster

[image: Description of Figure 1-1 follows]






The following list provides more detail about the installation order and other tasks to help you get started with Oracle Fail Safe:


	
On each cluster node, install:

	
Microsoft Windows Server on a private (system) disk.


	
Microsoft Distributed Transaction Coordinator and correctly configure for a cluster environment.




See Oracle Fail Safe Release Notes for information about the versions of Microsoft Windows that can be used with Oracle Fail Safe. The Oracle Fail Safe Web site contains more information about installing Microsoft Cluster Server.


	
On each cluster node for each Oracle product that you intend to install, create an Oracle home on a private disk (for example, the system disk). To minimize downtime during future upgrades, Oracle recommends that you use a separate Oracle home for each major component (for example, a separate Oracle home each for the database, application software, and Oracle Fail Safe). To allow applications to fail over, ensure that the Oracle homes on each cluster node have the same name. For example, name the Oracle Fail Safe home on each cluster node ofs_home, and name the database home on each cluster node dbs_home.


	
On each cluster node, install the optional Oracle software (Oracle Database and other applications) that you plan to use with Oracle Fail Safe. Place all application and database data, control, and log files on shared cluster disks so that they can fail over.

If you are installing Oracle Database software, you can create the database before or after you install Oracle Fail Safe. Create the database as you would in a noncluster environment, including the database listener. However, the database must be created on a cluster disk or disks.


	
On each cluster node, install the server component of Oracle Fail Safe, Oracle Services for MSCS. If you want, you can install the client component, Oracle Fail Safe Manager, at the same time.

See Chapter 2 for complete information about installing Oracle Fail Safe.


	
On one or more client systems, optionally, install Oracle Fail Safe Manager (for example, to set up additional management consoles).




Figure 1-2 lists the software and the files that should be installed on private disks and shared-nothing cluster disks.


Figure 1-2 Software Installed on Private, Shared-Nothing Cluster Disks

[image: Description of Figure 1-2 follows]










1.4 Adding a Node to an Existing Cluster

If you want to add a node to an existing cluster, perform the following operations:

	
Follow Microsoft's instructions to add a node to a cluster.


	
On the new node, install any desired optional Oracle software (Oracle Database and other applications) that you plan to use with Oracle Fail Safe. Install executable application files located on private disks (for example, on the system disk for each node).


	
On the new node, install Oracle Services for MSCS (which is the server component of Oracle Fail Safe). You can install Oracle Fail Safe Manager at the same time.









1.5 Adding a Sample Database

Oracle Fail Safe includes a Create Sample Database command that installs a preconfigured sample database on a cluster disk specified by the user. The sample database has limited functions and is intended only for testing purposes and for use with the online Oracle Fail Safe tutorial. The sample database should not be used for production. To create a database for production, use Database Configuration Assistant or create the database manually.






1.6 Postinstallation Procedures

After you have successfully installed Oracle Fail Safe, perform the following tasks:

	
If you installed optional Oracle software:

	
Configure application data and log files on the shared cluster disks.


	
Configure alert and trace files on either the shared cluster disks or on the private disk.

Configuring alert and trace files on private disks allows the administrator to determine the node on which problems occur, but requires that you maintain multiple sets of files. Placing parameter files on private disks is recommended only when you want the parameters to be different on each cluster node. For example, this can be useful if you want a database to use fewer resources on its failover node than on its primary node (such as when you know that another application or database on the failover node needs resources).

For information about re-creating databases on cluster disks, refer to the Import/Export documentation that is specific to your database.





	
Start Oracle Fail Safe Manager, connect to the cluster alias with a domain account that has Administrator privileges on each cluster node, and run the Verify Cluster operation when prompted.

See Chapter 3 for information to help you get started with Oracle Fail Safe.


	
Refer to the Oracle Fail Safe Tutorial for step-by-step information about creating a group and adding resources to it. (To run the tutorial from the Oracle Fail Safe Manager, select Help, and then select Tutorial.)


	
Run the fssvr command qualifier, /GETSECURITY, which is provided by Oracle Fail Safe on each cluster node. The /GETSECURITY qualifier displays security information about the system where the command is run.

The command and its associated output should be similar to the following:


fssvr /getsecurity

Looking up user account information for OracleMSCSServices.
The user account must be a domain user acount with local Administrator
privileges.  The user account must also have the 'Log on as batch job'
privilege.

    User account specified for OracleMSCSServices is NEDCDOMAIN\cluadmin 
    User account specified has local Administrator privileges 
    User account has the 'Log on as batch job' privilege 

Looking up user account information for Cluster Service. The user account 
must be a domain user account with local Administrator privileges. The user
account must also have the 'Log on as batch job' privilege.

    User account specified for Cluster Service is NEDCDOMAIN\cluadmin
    User account specified has local Administrator privileges 
    User account has the 'Log on as batch job' privilege 

Checking to see if DCOM is enabled.  DCOM must be enabled.
    DCOM is enabled.








2 Installing Oracle Fail Safe

This chapter provides step-by-step instructions for installing Oracle Fail Safe Manager, Oracle Services for MSCS, and additional server components specific to Oracle Fail Safe. 




	
Note:

If you are upgrading Oracle Fail Safe from an earlier release, see Appendix A for information about performing a rolling upgrade.







The discussions in this chapter assume that you have set up your hardware configuration, installed Microsoft Windows and configured Microsoft Windows Failover Clusters. If you plan to configure Oracle products or other components with Oracle Fail Safe, then install the component software before installing Oracle Fail Safe.

The following topics are discussed in this chapter:

	
Review the PreInstallation Checklist


	
Install the Oracle Fail Safe Software






2.1 Review the PreInstallation Checklist

Perform the following preinstallation checks:

	
Verify the release of any other Oracle software or third-party software that you plan to use with Oracle Fail Safe against the software compatibility guidelines that are documented in Oracle Fail Safe Release Notes.


	
If necessary, configure Microsoft Windows Failover Clusters and configure MSDTC.


	
Verify that the cluster is up and running on all nodes.


	
Remove the previous version of Oracle Fail Safe, if necessary.


	
Install additional components that you want to configure with Oracle Fail Safe (such as Oracle Database and so on).


	
If necessary, install Oracle Enterprise Manager.


	
Log on to the cluster nodes using the same domain user account that has Administrator privileges. The account from which you run Oracle Universal Installer must have Administrator privileges.









2.2 Install the Oracle Fail Safe Software

After you have installed Microsoft Windows Server, and have configured and validated the failover cluster as described in the Microsoft documentation, you are ready to install Fail Safe. Install Oracle Fail Safe on all cluster nodes, but perform the Oracle Services for MSCS installation sequentially on only one node at a time. Optionally, you can install Oracle Fail Safe Manager on the cluster nodes at the same time.

To install Oracle Fail Safe Manager on client systems, you must be running Microsoft Windows.

See the Oracle Fail Safe Release Notes for information regarding the required versions of Microsoft Windows and MSCS. 




	
Note:

If you decide to update a Microsoft Windows service pack from one supported version to another, you can do so regardless of whether Oracle Fail Safe or the software for resources that Oracle Fail Safe supports has been installed.







Perform the following steps to install Oracle Fail Safe.

	
	Step 1    Start Oracle Universal Installer.
	
Use Oracle Universal Installer, which is included in the Oracle Fail Safe software kit, to install Oracle Fail Safe.

Typically, after you insert the CD-ROM the Oracle Fail Safe Autorun window opens and presents three choices: Install/Deinstall Products, Explore CD, and Browse Documents. Click Install/Deinstall Products to begin the installation. If the Oracle Fail Safe Autorun window does not open when you insert the CD-ROM, then run the Oracle Fail Safe setup.exe program, which is on the CD-ROM.

Oracle Universal Installer automatically performs the installation procedure in the same language used by the operating system. For example, if the node operating system is in Japanese, then Oracle Universal Installer automatically performs the installation in Japanese.

When Oracle Universal Installer begins, a command interpreter window opens, indicating that the installer is checking prerequisites. If all prerequisites are met, then the Welcome window opens. If some or all prerequisite checks fail, then you are asked whether you want to continue. If you choose to continue, then the installation may fail.


	
	Step 2   Welcome Window: Verify installed components and Oracle homes.
	
When the Welcome window opens, you can optionally click Installed Products to view the Oracle components that are installed and the Oracle homes where they reside. Click Next when ready to proceed.





	
	Step 3   Specify File Locations Window: Specify the Oracle home directory for the Oracle Fail Safe installation.
	
In the Specify File Locations window, specify the source and destination paths, and the Oracle home, as follows:

	
Under Destination, in the Name box, enter a unique name for the Oracle home where you want to install the Oracle Fail Safe software.


	
Under Destination, in the Path box, enter the directory specification for the Oracle home entered in the previous step.


	
Click Next.










	
Note:

	
You must install Oracle Fail Safe on a private disk, not on a shared cluster disk.


	
You must install the Oracle Fail Safe server software (which includes Oracle Services for MSCS and additional Oracle Fail Safe server components) in one Oracle home, not in multiple Oracle homes. Oracle Universal Installer prevents you from installing Oracle Fail Safe server components in multiple Oracle homes. The name of the Oracle home must be the same on each node in the cluster. Although not required, Oracle recommends that the Oracle home path also be the same on each cluster node.












	
	Step 4   Installation Types Window: Select an installation type.
	
In the Installation Types window, specify the type of installation to perform, as follows:

	
Select an installation type:

	
Select Typical to install Oracle Fail Safe Manager and Oracle Services for MSCS. Typical is the default installation type.


	
Select Client Only to install Oracle Fail Safe Manager.


	
Select Custom or Reinstall to specify one-by-one which components you want to install or reinstall.





	
Click Next.





	
	Step 5   Available Product Components Window: Select components.
	
If you selected Typical or Client Only in Step 4, then go to Step 6. If you selected Custom or Reinstall in Step 4, then this window lets you specify which components to install, as follows:

	
To install the manager, select Oracle Fail Safe Manager.


	
To install Oracle Fail Safe server components and Oracle Services for MSCS, leave them selected.

By default, Oracle Fail Safe server components and Oracle Services for MSCS are selected. You must deselect the components that you do not want to install.

The Oracle Fail Safe server components have a dependency on Oracle Services for MSCS. Do not deselect one and not the other. However, you can choose to install just the manager by deselecting both Oracle Fail Safe server components and Oracle Services for MSCS or you can choose to install just the server software by deselecting Oracle Fail Safe Manager.







At this point, Oracle Universal Installer displays a window informing you that you must restart the node after the installation. (Step 8 in these instructions provides more information about restarting the node.) This window is not displayed if you have previously installed Oracle Fail Safe and the changes to the system path have been made and detected previously.


	
	Step 6   Summary Window: Verify the component installations.
	
The Summary window lists the components selected for this installation.

Verify that the information in the Summary window is correct. If the summary includes a component that you do not want to install, then click Previous to back up through the installation dialog box and deselect the component.







	
Note:

If your system does not have sufficient space to perform the installation, then the text below Space Requirements is displayed in red.







If the information in the Summary window is correct, then click Install to start the installation.

The Install window displays the progress of the installation, including the names of the files that are being installed.

Typically, the installation completes in 1 to 5 minutes.


	
	Step 7   Configuration Tools Window and Associated Dialog Box: Enter a domain user account for Oracle Services for MSCS.
	
If the installation is successful, then the Configuration Tools window and the Oracle Services for MSCS Account/Password dialog box open. In the Oracle Services for MSCS Account/Password dialog box enter:

	
A value in the Domain\Username box for a user account that has Administrator privileges

For example, if you are using the NEDCDOMAIN and your user name is cluadmin, then enter NEDCDOMAIN\cluadmin.


	
The password for the account in the Password and Confirm Password boxes




Oracle Services for MSCS uses the account you specify to access the cluster. Oracle Services for MSCS runs as a Microsoft Windows service (called OracleMSCSServices) under a user account that must be a domain user account (not the system account) that has Administrator privileges on all nodes of this cluster. The account must be the same on all nodes of this cluster, or you will receive an error message when you attempt to connect to a cluster using Oracle Fail Safe Manager.





	
	Step 8   End of Installation Window: Confirm the Installation and view the Oracle Fail Safe Release Notes.
	
Oracle Universal Installer displays the End of Installation window. To confirm the installation of Oracle Fail Safe and any additional components, click Installed Products.





	
	Step 9   Restart the cluster node if you are instructed to do so.
	
If a window is presented that instructed you to restart the cluster node, then do so after you exit the installer.


	
	Step 10    Verify the Oracle Fail Safe installation.
	
See Chapter 3 for information about verifying the Oracle Fail Safe installation.








3 Getting Started

This chapter contains the following topics to help you connect to a cluster and start using Oracle Fail Safe Manager:

	
Starting the Manager and Verifying the Oracle Fail Safe Installation


	
Oracle Fail Safe Manager Tutorial and Online Help






3.1 Starting the Manager and Verifying the Oracle Fail Safe Installation

After you install the Oracle Fail Safe software on all nodes in the cluster, you must verify the installation.

This section describes how to start Oracle Fail Safe Manager, connect to the cluster, and perform the tasks involved in installation verification.



3.1.1 Start Oracle Fail Safe Manager

After the installation is completed, start Oracle Fail Safe Manager from the Microsoft Windows taskbar by selecting Programs (or All Programs) from the Windows Start menu, then Oracle - ORACLE_HOME, then Oracle Fail Safe Manager. (ORACLE_HOME is the name of the Oracle home where you installed Oracle Fail Safe.)

When Oracle Fail Safe Manager opens, usually the Add Cluster to Tree dialog box also opens, as shown in Figure 3-1. If the Add Cluster to Tree dialog box does not open, from the File menu, select Add Cluster to Tree. In the Cluster Alias box, enter the alias for the cluster and then click OK.


Figure 3-1 Adding a Cluster to the Tree View

[image: Description of Figure 3-1 follows]






After you click OK in the Add Cluster to Tree dialog box, the cluster alias is added to the tree view, and the General tab for the cluster is displayed, as shown in Figure 3-2. However, because Oracle Fail Safe Manager is not yet connected to the cluster, the General tab displays the message: "Oracle Fail Safe Manager is not currently connected to this cluster. To connect, open the File menu, and select Connect to Cluster." The next section describes connecting to a cluster in detail.


Figure 3-2 Oracle Fail Safe Manager with a Cluster Added to the Tree View

[image: Description of Figure 3-2 follows]










3.1.2 Connect to the Cluster

After you add the cluster to the tree view, you must connect to the cluster. Open the Connect to Cluster dialog box by performing one of the following steps:

	
On the File menu, click Connect to Cluster.


	
Right-click the cluster alias, then click Connect.


	
Click the box to the left of the cluster alias (to expand the cluster alias folder).




The following list describes the input to the Connect to Cluster dialog box:

	
User Name

Enter a user name for a domain account name that has Administrator privileges on all nodes of the cluster where you are connecting.


	
Password

Enter the password for the account specified in the User Name field.


	
Cluster Alias

Contains the alias of the cluster that you selected from the tree view. The alias name is assigned to the cluster when you (or someone else) created the cluster with MSCS. A cluster alias is sometimes referred to as a cluster name.


	
Domain

Enter the name of the domain to which the user name belongs.


	
Save as local preferred credentials

Select to have Oracle Fail Safe Manager save the account information you have entered to a text file, ORACLE_HOME\fs\fsmgr\FsClusters.txt on the system from which you are running Oracle Fail Safe Manager. The password is saved in an encrypted format. This lets you disconnect and reconnect to the cluster (from your current system) without having to specify the account information each time a reconnection is requested.




Click OK or press Enter to connect to the cluster.

Cluster Alias, User Name, Password, and Domain should all be entered. The Save as Local Preferred Credentials option is not a required choice on any Microsoft Windows system. If you do not specify a user name, password, or domain, Oracle Fail Safe attempts to connect to the cluster using the account with which you logged on to the server node.

Once a connection to the cluster is made, the Oracle Fail Safe Manager main window expands the tree view.






3.1.3 Run Verify Cluster

The first time you connect to a cluster after you install Oracle Fail Safe, Oracle Fail Safe Manager prompts you to run the Verify Cluster operation to validate the Oracle Fail Safe installation and the network configuration. The Verify Cluster operation displays its progress in a Verifying Cluster window.

Later, you can run the Verify Cluster operation at any time by selecting Troubleshooting, then Verify Cluster from the Oracle Fail Safe Manager menu bar. This is especially useful if you later change your cluster configuration.

Verify Cluster performs operations to verify that:

	
The Oracle homes are identical on all nodes


	
The Oracle Fail Safe release is identical on all nodes


	
The resource providers are configured identically on all nodes


	
The resource providers are disabled if the required software has not been installed


	
The Host Name/IP Address mappings resolve consistently across all nodes in the cluster




Verify Cluster also registers with MSCS the resource DLLs for the resource types that Oracle Fail Safe supports.

For more information about Verify Cluster operations, refer to Oracle Fail Safe Concepts and Administration Guide.






3.1.4 Verify the OracleMSCSServices Service Entry

On successful installation and verification of Oracle Services for MSCS, the Services Control Panel on each cluster node must include a new service entry named OracleMSCSServices.

 To verify the OracleMSCSServices entry in the Services Control Panel:

	
Open the Windows Services Window.


	
Scroll down to the Oracle service listings and locate the OracleMSCSServices entry.

The Startup status for OracleMSCSServices is displayed as Started on the node where the Cluster Group resides, and it is displayed as Manual on the other cluster nodes.


	
Perform steps 1 and 2 on each cluster node.









3.1.5 Verify That Oracle Services for MSCS Is in the Cluster Group

The Oracle Services for MSCS service is maintained by MSCS. On successful installation of Oracle Services for MSCS on each cluster node, start MSCS Cluster Administrator and verify that it includes Oracle Services for MSCS as a resource in the Cluster Group (the group containing the MSCS resources critical to cluster operation).

To verify that Oracle Services for MSCS is listed as a resource, start MSCS Cluster Administrator, then click Cluster Group in the Cluster Administrator tree view to select it, and, in the right-hand side pane, locate the Oracle Services for MSCS entry in the Name column, as shown in Figure 3-3.


Figure 3-3 Oracle Services for MSCS in the Cluster Administrator Window

[image: Description of Figure 3-3 follows]










3.1.6 Verify That Oracle Resource DLLs Are Registered with MSCS

After installing Oracle Services for MSCS on all cluster nodes and verifying the cluster, start the MSCS Cluster Administrator and verify that it includes the cluster resource types for Oracle Fail Safe.

For example, if you have the database installed on the cluster nodes, start the MSCS Cluster Administrator. Then select Resource Types in the Cluster Administrator tree view, and, in the right-hand side pane, locate the Oracle Database and Oracle TNS Listener entries in the Display Name column.








3.2 Oracle Fail Safe Manager Tutorial and Online Help

For detailed step-by-step instructions about using Oracle Fail Safe Manager, refer to the Oracle Fail Safe tutorial and help. To access these online tools, from the Oracle Fail Safe Manager menu bar, select Help, then select Contents, or Help, and then select Tutorial for step-by-step instructions.

The online help is your primary source of information when you use Oracle Fail Safe Manager. For example, if you select Contents in the Help menu, the Help window displays the first help topic. If you select Search for Help on, a Help window opens to display Contents, Index, and Find tabs. You can find common tasks under the Contents tab and in the Index. The Find tab lets you perform a full text search of the Oracle Fail Safe Manager Help. To view the full set of Oracle Fail Safe documentation, select Online Manuals.

If the documentation was not installed on the system then the documentation options under the Help menu will be dimmed and will not be available.





4 Deinstalling Oracle Fail Safe

This chapter contains the following topics to help you to deinstall Oracle Fail Safe:

	
Deinstalling Oracle Fail Safe Release 3.n Software




You might want to deinstall Oracle Fail Safe, for example, to remove older software or to move Oracle Fail Safe software to another Oracle home. However, do not use the deinstallation instructions in this chapter as a method for upgrading the Oracle Fail Safe software to the current release. See Appendix A for information about performing a rolling upgrade. See Appendix B for information about performing a silent mode deinstallation.




	
Caution:

Do not evict a node from a cluster without first deinstalling Oracle Fail Safe. Evicting a node while Oracle Fail Safe is running will cause all MSCS metadata to be deleted, producing undesirable results. See Section 5.3 for more information.









4.1 Deinstalling Oracle Fail Safe Release 3.n Software

Deinstalling Oracle Fail Safe software involves removing resources from groups and reconfiguring them to run on a specific cluster node.

Perform the following steps to remove Oracle Fail Safe software.

	
	Step 1   Close Event Viewer
	
If you run the Windows Event Viewer and display any Oracle Fail Safe events, then you should close the Event Viewer before deinstalling Oracle Fail Safe.




	
	Step 2    Remove cluster resources from groups configured with Oracle Fail Safe Manager.
	
This step must be performed only on groups that were configured with Oracle Fail Safe. Do not perform this step on groups that were configured with MSCS (such as the Cluster Group).

Using Oracle Fail Safe Manager, perform the following tasks:




	
Move each group to the node that will host the standalone resources after Oracle Fail Safe is deinstalled.


	
Remove all resources from your groups.


	
Delete all groups.


	
Exit Oracle Fail Safe Manager.




	
	Step 3   Start Oracle Universal Installer and deinstall software.
	
Start Oracle Universal Installer and perform the following tasks:




	
Click Deinstall Products to display Inventory dialog box.


	
Select the Oracle home that contains the Oracle Fail Safe release 3.n software.


	
Expand the tree view and select the check box next to Oracle Fail Safe 3.n.


	
Click Remove.




	
	Step 4    Exit Oracle Universal Installer.
	
Click Exit to exit Oracle Universal Installer.








5 Troubleshooting Installation Problems

This chapter provides general information to help you troubleshoot problems with Oracle Fail Safe installations and deinstallations. The following topics are covered in this chapter:

	
Problems With the FSCMD Command After an Upgrade


	
Problems Installing Oracle Services for MSCS


	
Problems Deinstalling Oracle Fail Safe and MSCS Software


	
Problems With the User Rights Policy


	
Network Configuration Problems






5.1 Problems With the FSCMD Command After an Upgrade

Prior to release 3.4.2 the ORACLE_HOME\fs\fsmgr\bin directory was included in the system path environment variable, thus a full directory specification was not needed to invoke the FSCMD command. In 3.4.2 and later the directory is no longer in the system path environment variable.

The FSCMD executable is located in ORACLE_HOME\fs\fsmgr\bin directory, where ORACLE_HOME is the Oracle Fail Safe home directory. If you have not set your directory to ORACLE_HOME\fs\fsmgr\bin, you must specify the full path when running the FSCMD command.






5.2 Problems Installing Oracle Services for MSCS

If you are running Oracle Universal Installer on a system that does not have MSCS installed (such as a client system) and you try to install Oracle Services for MSCS, then the installer will open an error window to display an error that states that the Oracle Services for MSCS must be installed on a cluster running Microsoft Cluster Server. You must configure Windows failover cluster prior to installing Oracle Services for MSCS.

If such a message is displayed, do not continue with the installation. Click OK to back up through the installation windows and choose a Client Only installation. See Chapter 2 for more information about Client Only installation.






5.3 Problems Deinstalling Oracle Fail Safe and MSCS Software

Chapter 4 warns against evicting a node from a cluster before deinstalling Oracle Fail Safe. If you evict a node on all cluster nodes, then the cluster metadata information about Oracle Fail Safe will be removed.

If you evict a node from only one cluster node, then the cluster metadata information is still available on the other node or nodes. To prevent the loss of the cluster metadata, do not evict a node from a cluster; reinstall MSCS on the first node and click Join an Existing Cluster when prompted by the installation procedure to add the node back to the cluster and recover the cluster metadata.

If you accidentally evict a node on all cluster nodes before you deinstall Oracle Fail Safe, then you can recover your databases (after you reinstall MSCS on all cluster nodes) by performing the following steps using Oracle Fail Safe Manager:

	
Select the standalone resource in the Oracle Fail Safe Manager tree view.


	
Select the Verify Standalone Database operation from the Resources menu.


	
Enter the standalone database information in the Verify Standalone Database window.


	
When the verification completes successfully, add the standalone resource to a group using the Add Resource to Group Wizard.




	
Note:

It might be necessary to manually restore the configuration of other non-database resources, such as Oracle Application Server.















5.4 Problems With the User Rights Policy

For Oracle Services for MSCS to run, the "Log on as batch job" and "Log on as a service" user rights policy must be enabled for the user account under which Oracle Services for MSCS runs. Typically, the Oracle Fail Safe installation enables this policy for the user account during the security setup. However, in some situations, the user rights policy might not be enabled correctly on a backup domain controller (BDC), because the account database on the BDC is read-only and cannot be changed directly.

To solve the problem, perform these steps:

	
Perform one of the following operations:

	
If the primary domain controller (PDC) is part of the cluster, then install Oracle Fail Safe on the PDC.


	
If the PDC is not part of the cluster, then grant "Log on as batch job" and "Log on as a service" rights to the Oracle Services for MSCS user account on the PDC.





	
Synchronize the account database with the BDCby using the Server Manager administration tool.


	
Install Oracle Fail Safe on the BDC.









5.5 Network Configuration Problems

If you receive error messages regarding problems with the mapping of host names to IP addresses (such as FS-10514 and FS-10515), see the appendix on network configuration requirements in the Oracle Fail Safe Concepts and Administration Guide.





A Rolling Upgrades and Patches

Oracle Fail Safe allows a cluster system to continue to provide service while the software is being upgraded to the next release. This process is called a rolling upgrade because each node is upgraded and restarted in turn, until all server nodes and all client nodes have been upgraded. You might want to perform a rolling upgrade for the following reasons:

	
To upgrade the Oracle Fail Safe software or install patches


	
To upgrade or patch a highly available Oracle single-instance database


	
To upgrade or patch other Oracle software




When you upgrade Oracle software, do not start the installation procedure while any Oracle Fail Safe Manager operations or MSCS Cluster Administrator operations are in progress on groups. You must wait for a quiet period in cluster operations before you proceed with the steps described in this appendix.




	
Note:

To ensure minimal downtime and to identify any potential issues with other software that might be running on the cluster, Oracle recommends that you test the operations described in this appendix on an identically configured test cluster before you upgrade the production cluster.







This appendix includes the following topics:

	
Preparing Users for the Upgrade


	
Recommended Order for Upgrading Software


	
Upgrading the Oracle Fail Safe Software and Installing Patches


	
Upgrading or Patching a Highly Available Oracle Database


	
Upgrading Other Oracle Product Software






A.1 Preparing Users for the Upgrade

During a rolling upgrade, you need to perform a planned failover to make the cluster resources running on one node move to another node. Each planned failover will disconnect users and cause a rollback of any interrupted, uncommitted work if a database is involved in the operation.

This brief outage typically is less than 1 minute and always is less than the downtime that would be experienced by users if Oracle Fail Safe was not installed. To prevent loss of work, notify users that you plan to shut down the system, and have all users commit their work and log off before you perform the failover. Advise users when they can reconnect and resume work after the database fails over to another cluster node.

While you are performing upgrades to a two-node cluster, remember that failback is disabled and your cluster is not protected against failures. In addition, each time that you stop and restart the cluster service on a node (with MSCS Cluster Administrator), all remaining cluster resources running on the node fail over to another node with a similar brief loss of service.






A.2 Recommended Order for Upgrading Software

Oracle recommends the following procedure for upgrading software on your cluster when just the database software or both the database software and Oracle Fail Safe software must be upgraded.

	
Remove each database from its group.


	
Upgrade the Oracle Database software and the Oracle Fail Safe software if required. The order in which you perform these two upgrades is not important.


	
Add each database back to its group.




If you are only performing an Oracle Fail Safe software upgrade or applying a patch to the database software (but you are not going to upgrade the database software), then you do not need to remove any database from its group prior to performing the upgrade or applying the patch.

Patching typically involves updating the software from one release to another where only the fourth or fifth digit in the release number changes, for example, 9.2.0.1 to 9.2.0.2. An upgrade is required when the first, second, or third digit in the release number changes, for example 9.0.1 to 9.2.0 or 9.0.1 to 10.0.1.






A.3 Upgrading the Oracle Fail Safe Software and Installing Patches

This section describes how to perform a rolling upgrade when you want to upgrade the Oracle Fail Safe software on a cluster that is currently running Oracle Fail Safe (for example, to upgrade the cluster from Oracle Fail Safe release 3.3.2 to release 3.3.3). The tasks described in this section apply to upgrades from any Oracle Fail Safe release before the current Oracle Fail Safe release.

If you are performing a rolling upgrade of the Oracle Fail Safe software, then you must upgrade the Oracle Services for MSCS and Oracle Fail Safe Manager software clusterwide. You cannot run multiple releases of the Oracle Services for MSCS software on the same cluster. See the Oracle Fail Safe Release Notes for information about the compatibility of various Oracle Fail Safe Manager releases with various releases of Oracle Fail Safe Server or Oracle Services for MSCS.

Perform the steps described in Table A-1 on only one cluster node at a time.


Table A-1  Steps Required to Upgrade to Oracle Fail Safe

	Step	Task	Tool	Comments
	
1

	
Change the group attributes to the Prevent Failback mode for each group.

	
Oracle Fail Safe Manager

	
Select a group from the Oracle Fail Safe Manager tree view, select the Failback tab, make a note of the current settings, and then change the setting to Prevent Failback. Repeat these steps for each group in the cluster.

Changing the failback attributes prevents the group from failing back after its preferred node is restarted (later in Step 6).


	
2

	
Move groups off the node on which you plan to perform the upgrade.

	
Oracle Fail Safe Manager

	
In the tree view, select a group name, then select Move to a Different Node. Repeat for each group on the node. By moving groups to another node, you can upgrade the current node while users continue to access the group on another node. When moving groups that contain databases with this method, Oracle Fail Safe will perform a checkpoint operation.


	
3

	
Exit Oracle Fail Safe Manager.

	
Oracle Fail Safe Manager

	
From the File menu, select Exit.

Note: Do not use Oracle Fail Safe Manager on other cluster nodes during the rest of the upgrade procedure until you run Verify Cluster in Step 10.


	
4

	
Deinstall the previous release of Oracle Fail Safe Manager and Oracle Services for MSCS.

	
Oracle Universal Installer

	
See Chapter 4 for instructions.


	
5

	
Restart the Cluster Service service

	
Windows Services

	
The Cluster Service service must be restarted to eliminate all references to Fail Safe executables and message files.


	
6

	
Install the current release of Oracle Fail Safe.

	
Oracle Fail Safe installation CD-ROM

	
You must install the same release of Oracle Fail Safe software on all server nodes in the cluster. Follow the installation instructions in Chapter 2.


	
7

	
Restart the node.

	
Microsoft Windows

	
Note: You must wait until the first node is finished restarting before you begin installing Oracle Fail Safe on other nodes.


	
8

	
Move groups that contain Oracle databases to the upgraded node.

	
MSCS Administrator

	
Move cluster groups that contain Oracle databases to the upgraded node.

Note: To avoid problems that can arise due to version mismatches, do not use Oracle Fail Safe Manager to perform this task; use MSCS Administrator.


	
9

	
Repeat steps 4 through 6 on the other cluster node or nodes.

	
Various

	
No comments.


	
10

	
Install Oracle Fail Safe Manager on client nodes.

	
Oracle Fail Safe installation CD-ROM

	
See the Oracle Fail Safe Release Notes for information about which releases of Oracle Fail Safe Manager can be used with various releases of Oracle Services for MSCS.


	
11

	
Run the Verify Cluster operation.

	
Oracle Fail Safe Manager

	
Right-click the cluster name in the tree view, then select Verify Cluster.

This step verifies that there are no discrepancies in the software installation (such as with the release information) on each node in the cluster, and registers resource DLLs.


	
12

	
Review the Verify Cluster report.

	
Oracle Fail Safe Manager

	
Carefully review each error or warning and take corrective action if necessary.


	
13

	
Restore the failback policy attributes on the groups.

	
Oracle Fail Safe Manager

	
Select a group from the Oracle Fail Safe Manager tree view, select the Failback tab, and restore the original settings (as noted in Step 1). Repeat for each group on the cluster.


	
14

	
Move each group back to its preferred node.

	
Oracle Fail Safe Manager

	
In the tree view, right-click the group, then select Move to a Different Node. If you are working in a two-node cluster, then you will be asked to confirm the move to the other node. If you are working in a cluster that contains more than two nodes, then you will be asked to select the destination node.

This step redistributes the workload across the nodes in the cluster.


	
15

	
Run the Verify Group operation on all groups.

	
Oracle Fail Safe Manager

	
In the tree view, right-click a group, then select Verify Group to check all resources in all groups and confirm that they have been configured correctly. Repeat for each group in the cluster.

See the Oracle Fail Safe Concepts and Administration Guide for a description of the validation tests performed during a Verify Group operation.












A.4 Upgrading or Patching a Highly Available Oracle Database

This section describes how to patch or perform a rolling upgrade on a database that has been configured for high availability using Oracle Fail Safe. As mentioned previously, patching typically involves updating the database from one release to another where only the fourth or fifth digit in the release number changes, for example, 9.2.0.1 to 9.2.0.2. An upgrade is required when the first, second, or third digit in the release number changes, for example 9.0.1 to 9.2.0 or 9.0.1 to 10.0.1.

This section contains the following topics:

	
Upgrading a Database Configured for High Availability


	
Patching an Oracle Database Configured for High Availability






A.4.1 Upgrading a Database Configured for High Availability

An upgrade requires installing a new version of the database. Typically, it is installed into its own Oracle home, separate from the earlier version of the database and from the home into which Oracle Fail Safe was installed.

To save time, you can install the new database version on each cluster node while the old version of the database is still running in an Oracle Fail Safe group.

Consider performing a database backup prior to any major upgrade.

Perform the steps in Table A-2 to perform the upgrade. Perform the steps described on one cluster node at a time.


Table A-2  Steps for Upgrading a Database Configured for High Availability

	Step	Task	Tool	Comments
	
1

	
Check compatibility

	
Not applicable

	
Ensure that the release of the database to which you plan to upgrade is compatible with the version of Oracle Fail Safe you are running. See the section on software compatibility in the Oracle Fail Safe Release Notes. If the Oracle Database release and the Oracle Fail Safe software release are not compatible, then see Section A.3.


	
2

	
Install the Oracle Database software on each cluster node.

	
Oracle Universal Installer

	
Use the same directory and Oracle home name on each cluster node.


	
3

	
Remove each database from its group.

	
Oracle Fail Safe Manager

	
In the tree view, right-click the database and select Remove from Group. Repeat for each database that you plan to upgrade.


	
4

	
Upgrade each database.

	
Database Migration Assistant (or perform manually)

	
Instructions for performing the upgrade are included in the database upgrade (or migration) manual for the release to which you are upgrading.


	
5

	
Verify each standalone database

	
Oracle Fail Safe Manager

	
Right-click the database in the tree view and select Verify Standalone Database. Correct any reported problems.


	
6

	
Add each database back to its original group.

	
Oracle Fail Safe Manager

	
Right-click the database, then select Add to Group and follow the steps through the Add Resource to Group Wizard.












A.4.2 Patching an Oracle Database Configured for High Availability

When you patch a database that has been configured for high availability, it is not necessary to remove the database from the group prior to applying the patch.

Table A-3 describes how to patch databases configured for high availability in a two-node cluster. These steps assume that there are two nodes, Node A and Node B, and that Node A is the first node that will be patched. Perform these steps on only one cluster node at a time.


Table A-3  Steps for Patching a Database Configured for High Availability

	Step	Task	Tool	Comments
	
1

	
Change the failback attributes to Prevent Failback for each group in the cluster.

	
Oracle Fail Safe Manager

	
In the tree view, select a group name, then select the Failback tab. Make a note of the current settings, and then change the setting to Prevent Failback. Repeat these steps for each group in the cluster.

This step prevents the group from failing back to its current node while the node is being restarted or when the cluster service is restarted.


	
2

	
Move all groups on Node A to Node B.

	
Oracle Fail Safe Manager and MSCS Cluster Administrator

	
In the tree view, select a group from Node A, and then select Move to a Different Node. Repeat for each group on Node A.

Use MSCS Cluster Administrator to move the Cluster Group if it is on Node A.

By moving all groups to another node, you can work on the current node. Oracle Fail Safe will perform a checkpoint operation on any databases within a group that is moved.


	
3

	
Exit Oracle Fail Safe Manager and Cluster Administrator.

	
Oracle Fail Safe Manager and MSCS Cluster Administrator

	
In the File menu, select Exit.

(The steps are the same in both Oracle Fail Safe Manager and MSCS Cluster Administrator.)


	
4

	
Stop the cluster service on Node A.

	
Microsoft Control Panel

	
Open the Microsoft Windows Services window and then stop the Cluster Services service.


	
5

	
Stop all running Oracle applications and all remaining Oracle services.

	
Microsoft Control Panel

	
Open the Microsoft Windows Services window and then stop all running Oracle services, including the Oracle Fail Safe service and the Distributed Transaction Coordinator Service (if it is running).


	
6

	
Install the database patch in the correct home on Node A.

	
Oracle Universal Installer

	
Follow the instructions that come with the patch. If you did not stop the Distributed Transaction Coordinator Service in Step 5, then it is likely that a write error for OCIW32.DLL will be returned. If this happens, then return to Step 5, stop the service, and then click RETRY in the Installer window.


	
8

	
Adjust the initialization parameter file, if needed.

	
Editor of choice for pfile, SQL ALTER SYSTEM statement for spfile.

	
Changes to the initialization parameter file should be made before databases are failed back. See the readme file supplied with the database patch for information about required parameter file changes. If you are maintaining multiple copies of the initialization parameter file (because you are maintaining them on private disks), then ensure that you update the file that will be used when the database is moved back to the current node. Once the patch scripts are completed, you will change the initialization parameter file back to the original values and restart the database.


	
9

	
Move groups back to the selected node.

	
Oracle Fail Safe Manager

	
Once the groups are moved back to Node A, they will be restarted and running under the patched version of the database management system. Therefore, run the patch scripts as soon as the groups are moved back. By having changed the initialization parameter file as described in Step 8, you ensure that the database starts with the parameters needed to complete the patch.


	
10

	
See Table A-4 for instructions on migrating to a new database release.

	
Various

	
See Table A-4 for the steps.


	
11

	
Restrict user access on each database to be upgraded.

	
SQL*Plus

	
As each database comes online on the selected node, restrict user access with the following SQL statement:


ALTER SYSTEM ENABLE RESTRICTED SESSION;


Do this as soon as possible after the database instance starts to prevent users from connecting to the database while the upgrade scripts run. You can also take the listener service for the group offline to prevent users from making Oracle Net connections.


	
12

	
Run the upgrade scripts for the patch against each database being patched.

	
SQL*Plus

	
See the readme file supplied with the database patch.


	
13

	
Repeat steps 4 through 7, replacing Node A in the instructions with Node B.

	
Various

	
To save time, you can run the upgrade scripts against the databases on Node A while the patch is being installed on Node B.


	
14

	
Verify each group in the cluster.

	
Oracle Fail Safe Manager

	
In the tree view, right-click a group name, then select Verify Group. Repeat for each group in the cluster.


	
15

	
End the restricted session on each database.

	
SQL*Plus

	
End the restricted session on each database with the following SQL statement:


SQL> ALTER SYSTEM DISABLE RESTRICTED SESSION;


	
16

	
Verify the cluster.

	
Oracle Fail Safe Manager

	
In the tree view, right-click the cluster name, then select Verify Cluster.


	
17

	
Restore the failback policy on each group.

	
Oracle Fail Safe Manager

	
Select a group from the Oracle Fail Safe Manager tree view, select the Failback tab, and restore the original settings (as noted in step 1). Repeat for each group on the cluster.


	
18

	
Move each group back to its preferred node.

	
Oracle Fail Safe Manager

	
In the tree view, right-click a group name, then select Move to a Different Node. Repeat for each node in the cluster.

This step balances the workload across the nodes in the cluster.








For information about database upgrades, refer to the Oracle Fail Safe Concepts and Administration Guide and to the upgrade instructions for Oracle Database Upgrade Assistant.

For Oracle release 9.2 and later, when any type of patch is applied, the database must be started with the MIGRATE option, as shown in Table A-4.


Table A-4  Steps for Starting Up a Database with the MIGRATE Option

	Step	Task	Tool	Comments
	
1

	
Take the database offline.

	
Oracle Fail Safe Manager

	
In the tree view, right-click the database, then select Take Offline.


	
2

	
Exit Oracle Fail Safe Manager.

	
Oracle Fail Safe Manager

	
From File menu, select Exit.


	
3

	
Manually start the service for the instance

	
Microsoft Windows Services Window

	
Instance service names are of the form, ORACLESERVICESOFS1


	
4

	
Start up the database with the MIGRATE option.

	
SQL*Plus

	
For example,


c:\> SET ORACLE_SID=OFS1
c:\> SQLPLUS "/as sysdba"
SQL> STARTUP MIGRATE


	
5

	
Run the upgrade scripts against each database being patched.

	
SQL*Plus

	
See the readme file supplied with the database patch.


	
6

	
Shut down the database and stop the service.

	
SQL*Plus and Microsoft Windows Services Window

	
See the readme file supplied with the database patch.


	
7

	
Place the database resource online.

	
Oracle Fail Safe Manager

	
In the tree view, right-click the database, then select Place Online.


	
8

	
Resume the steps in table Table A-3, Step 12.

	
Various

	
You are being directed to skip step 11 in Table A-3 intentionally. When you start up a database with the MIGRATE option, the session is restricted automatically.














A.5 Upgrading Other Oracle Product Software

This section describes upgrading non-database Oracle product software and installing patches that require you to stop the Oracle services being used by Oracle Fail Safe. See Section A.4 for the same information on Oracle Database software.

If your cluster is in an active/passive configuration, then you can eliminate a failover if you start the rolling upgrade on the passive cluster node. Once you have finished the upgrade on the passive cluster node, you can skip to Step 4 in Table A-5.

Perform the steps on only one cluster node at a time.


Table A-5  Steps Required to Upgrade Other Oracle Product Software

	Step	Task	Tool	Comments
	
1

	
Change the group failback attributes to the Prevent Failback mode.

	
Oracle Fail Safe Manager

	
Select a group from the Oracle Fail Safe Manager tree view, select the Failback tab, make a note of the current settings, and then change the setting to Prevent Failback. Repeat these steps for each group in the cluster.

Changing the failback attributes prevents the group from failing back to the node while it is being restarted or when the cluster service is restarted.


	
2

	
Move groups off the node on which you plan to perform the upgrade.

	
Oracle Fail Safe Manager

	
In the Groups menu, select Move to a Different Node. By moving all groups to another node, you can work on the current node. When you use this method to move groups that contain databases, Oracle Fail Safe performs a checkpoint operation.


	
3

	
Exit Oracle Fail Safe Manager.

	
Oracle Fail Safe Manager

	
On the current node, in the File menu, select Exit.


	
4

	
Stop the cluster service on the node where you want to install the software.

	
Microsoft Control Panel

	
Open the Services window and stop the Cluster Service.


	
5

	
Stop all running Oracle applications and all remaining Oracle services.

	
Microsoft Control Panel

	
Open the Services window and then stop all running Oracle services, including the Oracle Fail Safe service.


	
6

	
Install the new Oracle product or component software.

	
Oracle Universal Installer

	
Follow the instructions that come with the Oracle product or component.


	
7

	
Restart the node.

	
Microsoft Windows

	
Restarting the node automatically restarts the cluster service on the node where you just installed the Oracle software. Restarting the cluster service is essential for the changes to take effect.


	
8

	
Run the Verify Group operation on all groups.

	
Oracle Fail Safe Manager

	
In the tree view, right-click a group name, then select Verify Group to check all resources in the group and confirm that they have been configured correctly. Repeat for each group in the cluster.


	
9

	
Repeat steps 2 through 8 on the other server node or nodes in the cluster.

	
Various

	
No comments.


	
10

	
Run the Verify Cluster operation.

	
Oracle Fail Safe Manager

	
In the tree view, right-click the cluster name, then select Verify Cluster.

This step verifies that there are no discrepancies in the software installation (such as with the release information) on each node in the cluster.


	
11

	
Restore the failback policy attributes on the groups.

	
Oracle Fail Safe Manager

	
Select a group from the Oracle Fail Safe Manager tree view, select the Failback tab, and restore the original settings (as noted in step 1). Repeat for each group on the cluster.


	
12

	
Move each group back to its preferred node.

	
Oracle Fail Safe Manager

	
In the tree view, right-click a group name, then select Move to a Different Node. Repeat for each node in the cluster.

This step balances the workload across the nodes in the cluster.














B Silent Mode Installations and Deinstallations

This appendix describes how to perform a silent mode installation or deinstallation of Oracle Fail Safe.

The following topics are discussed in this appendix:

	
Introduction to Silent Mode Installations and Deinstallations


	
Steps for a Silent Mode Installation or Deinstallation


	
Contents of a Response File






B.1 Introduction to Silent Mode Installations and Deinstallations

A silent mode installation or deinstallation is a mode that lets you install or deinstall software by supplying input to Oracle Universal Installer in a file, rather than through Oracle Universal Installer graphical user interface (GUI).

If you are performing multiple installations or deinstallations of Oracle Fail Safe that are identical or similar to each other, you may want to run Oracle Universal Installer in silent mode to automate the process. You do this by editing a file, called a response file, that is supplied with Oracle Fail Safe.

A response file contains the answers that you typically provide in an interactive installation or deinstallation session. By providing all input in a response file, which you run using the command-line interface or in batch mode, you eliminate the need for direct interaction from the user, and a GUI is not displayed.

To perform a silent installation or deinstallation with a response file, use the command-line mode or a batch script to start Oracle Universal Installer and enable the response file.

A silent installation or deinstallation is the only alternative to using the Oracle Universal Installer GUI; there is no character-mode version of Oracle Universal Installer.




	
Note:

You cannot use response files to reinstall Oracle Fail Safe. If you need to reinstall Oracle Fail Safe, you must use Oracle Universal Installer interface to perform the reinstallation, or you must first deinstall Oracle Fail Safe and then use response files to install the software again.









B.1.1 Selecting a Response File

Three different response file templates are available in the Oracle Fail Safe installation kit. These response files help you to set up Oracle Fail Safe installations and deinstallations in silent mode. Although each template file performs a different type of installation, you can use any one of them to perform a deinstallation.

To perform a silent installation, choose a response file template that corresponds to the desired installation type. The template files are located on the CD-ROM in the \stage\Response directory. Sample response files have also been provided.

The template files, samples, and their corresponding installation types are listed in the following table:


	Template Name	Sample Name	Installation Type
	oracle.failsafe.complete.typical.rsp	failsafe.typical.rsp	Typical installationFoot 1 
	oracle.failsafe.complete.client.rsp	failsafe.client.rsp	Client Only installation
	oracle.failsafe.complete.custom.rsp	failsafe.custom.rsp	Custom installation






Footnote 1 The Typical installation type installs all of the Oracle Fail Safe components.






B.1.2 Validating Values from the Response File

During an installation or deinstallation session, Oracle Universal Installer retrieves and uses values from the response file according to the conditions described in the following list:

	
If the response file does not contain values for one or more required variables, then Oracle Universal Installer stops the installation or deinstallation.


	
If any variable that is specified in the response file contains invalid content, format, or type value, then Oracle Universal Installer ignores the specified value.


	
If any variable is specified outside of a response file section, then Oracle Universal Installer ignores the variable.









B.1.3 Locating the silentInstall.log File

When you perform a silent installation or deinstallation, the success or failure of the operation is recorded in a file named silentInstall.log. The file is located in the Oracle installation log area, such as C:\Program Files\Oracle\Inventory\logs.

Oracle Universal Installer does not write to the log file until after the silent installation or deinstallation has completed.








B.2 Steps for a Silent Mode Installation or Deinstallation

The following steps describe how to customize the variables in a response file and enable Oracle Universal Installer to use the file for a silent mode installation or deinstallation.

	
	Step 1    Copy the response file template from the CD-ROM.
	
Make a copy of the original response file templates (located on the CD-ROM in the \stage\Response directory) to use as the basis for your response file. Retain the original files for use as templates.

You might want to make several copies of a response file, each with a different purpose, and specify a different name for each one. For example, you might have a response file named failsafemanager.rsp that performs only Oracle Fail Safe Manager installations.


	
	Step 2    Edit the response file.
	
Edit the response file to specify options for your Oracle Fail Safe installation.




	
Note:

Before editing the response file, read Section B.3, which contains important information about editing the variables in the response file.







The response file templates contain all of the Oracle Fail Safe installation variables for the corresponding installation type. There are variables that specify the name of the Oracle home where you want to install Oracle Fail Safe, the installation type (Typical, Custom, or Client Only), and the account user name and password for the Oracle Fail Safe service. You can use any one of the response file templates for a deinstallation.

In the response files, each variable is documented using comment lines that begin with a number sign (#). The comments contain information about the type of the variable, whether the variable is displayed in a dialog box, and the function of the variable. 

The following sections describe how to perform the installations or a deinstallation. Except where noted, the variables respond in the same way, in each of the response file templates. The variables used in the following sections are also documented in Table B-1, Table B-2, and Table B-3.





For All Installation Types:  Edit the following variables to specify the name of the Oracle home where you want to install Oracle Fail Safe:

ORACLE_HOME

ORACLE_HOME_NAME


For a Typical Installation: To install all Oracle Fail Safe components:

	
Use the oracle.failsafe.complete.typical.rsp response file template.


	
Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.4.2.0.0] Component section and make sure the value is INSTALL_TYPE="Typical". (This is the default setting.)


	
Locate the DomainUserName and Pwd variables at the end of the file. Edit these variables with the account domain, user name, and password needed by Oracle Fail Safe.





For a Client Only Installation:  To install Oracle Fail Safe Manager only:

	
Use the oracle.failsafe.complete.client.rsp response file template.


	
Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.4.2.0.0] Component section and ensure that the value is INSTALL_TYPE="install_type_1". (This is the default value.)





For a Custom Installation:  To perform a customized installation of Oracle Fail Safe:

	
Use the oracle.failsafe.complete.custom.rsp response file template.


	
Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.4.2.0.0] Component section and make sure the value is INSTALL_TYPE="Custom" (this is the default value).


	
Locate the DomainUserName and Pwd variables at the end of the file. Edit these variables with the account domain, user name, and password needed by Oracle Fail Safe.


	
Specify the components to be installed in the DEPENDENCY_LIST variable.





For a Deinstallation: To perform a deinstallation:

	
Use any one of the response file templates.


	
Update the variables described in Table B-2. These are the only variables of concern for a deinstallation.




	
	Step 3   Run Oracle Universal Installer in silent mode.
	
On each system where you want to install or deinstall Oracle Fail Safe, run Oracle Universal Installer using the following command syntax at the command-line prompt or in a batch file:

E:\stage\Disk1\install\setup.exe -responseFile filename -silent [-nowelcome | -deinstall]

In the example, E: is the drive letter for the CD-ROM. The following list explains the syntax in the command line:




	
setup.exe runs Oracle Universal Installer.


	
-responseFile indicates that you are supplying a response file for this installation.


	
filename specifies the full path name of the response file that you want to use to provide input to Oracle Universal Installer.


	
-silent indicates that you want to run Oracle Universal Installer in silent mode.


	
-nowelcome is an optional command parameter that suppresses the welcome dialog box that is displayed during an installation.


	
-deinstall specifies that the response file is to be used for a deinstallation. If this qualifier is not specified, then an installation is assumed.




The Oracle Fail Safe silent installation and deinstallation are case-sensitive. You must enter all command-line syntax exactly as shown in this chapter (for example, the -responseFile parameter must be entered using all lowercase characters, except for the F). You must enter the file specification by using the case shown in Microsoft Windows Explorer (for example, C:\Ofs\Silent_Install\OfsProducts.rsp).

The following command performs an Oracle Fail Safe installation in silent mode by reading all required installation information from the failsafe.rsp file:


E:\stage\Disk1\install\setup.exe -responseFile C:\failsafe.rsp -silent -nowelcome


The following command performs an Oracle Fail Safe deinstallation in silent mode by reading the deinst_failsafe.rsp file:


E:\stage\Disk1\install\setup.exe -responseFile C:\deinst_failsafe.rsp -silent -deinstall


	
	Step 4   Delete the installation response file or move it to a secure location.
	
Because the response file for an installation specifies the domain, user name, and password information in the DomainUserName and Pwd variables, ensure that you either delete the response file for an installation or move it to a secure location on your system after the installation is completed.









B.3 Contents of a Response File

The next three sections in this appendix describe the contents of the response file templates that are provided with Oracle Fail Safe. Edit the variables in your copy of the file to contain the responses you would need to provide during the Oracle Fail Safe installation session. Use the following format when you specify values for variables in the response file:

variable name = recommendation : value

Set the variable name and value parameters as described in Table B-1, Table B-2, and Table B-3. Set the optional recommendation variable to either Forced or Default, as follows:

	
Forced: does not display the setting for the value parameter during installation or deinstallation; the user cannot change any variable values during the silent installation or deinstallation.


	
Default: displays the default setting for the value parameter during the installation or deinstallation and allows the user to choose another value.




Each response file contains at least three sections: General, Session, and one or more Component sections. Each section begins with a line that specifies the section name in brackets (for example, the General section begins with [General]).




	
Note:

Use a response file only to perform silent installations or deinstallations for Oracle Fail Safe. Do not use the response files that are provided with Oracle Fail Safe to install or deinstall any other products.









B.3.1 General Section

The General section is an informational section that contains the version number of the response file. There is only one General section for each response file. For example:


[General]
RESPONSEFILE_VERSION=2.2.1


Do not edit information in the General section.






B.3.2 Session Section

The Session section lists predefined (generic) dialogs for Oracle Universal Installer and shows whether the dialogs are visible to the user.

The Session section also lists global variables that are set during one installation or deinstallation session (from the start of the installation or deinstallation to the end of installation or deinstallation). These variables include top-level components and languages.

If you are performing an installation, then the variables used only for deinstallation are ignored. Similarly, if you are performing a deinstallation, then the variables used only for installation are ignored. For example, if you specify -deinstall on the command line, then any value you have set for the FROM_LOCATION variable is ignored.




	
Note:

When you specify the -silent qualifier on the command line, none of the installation (or deinstallation) dialog boxes are displayed, regardless of the variable settings in this section.
The only variables that are used during an installation when you specify the -silent qualifier are the following:

	
FROM_LOCATION


	
FROM_LOCATION_CD_LABEL


	
ORACLE_HOME


	
ORACLE_HOME_NAME


	
TOPLEVEL_COMPONENT




The only variables that are used during an deinstallation when you specify the -silent qualifier are the following:

	
DEINSTALL_LIST


	
ORACLE_HOME


	
ORACLE_HOME_NAME












Table B-1 provides a list of the variables in the Session section that can be used in a silent mode installation.

Table B-2 provides a list of the variables in the Session section that can be used in a silent mode deinstallation.


Table B-1  Variables for the Session Section for a Silent Mode Installation

	Variable Name	Value	Type	Required?
	
FROM_LOCATION

	
Specifies the "From" location in the installer, which is a directory path containing the source of the products to be installed.

	
String

	
Yes


	
FROM_LOCATION_CD_LABEL

	
Specifies the label of the CD-ROM where the products.jar file exists. The label can be found in the file "disk.label" in the same directory as products.jar. This variable should be used only in multi-CD-ROM installations.

	
String

	
No


	
NEXT_SESSION

	
Specifies whether or not you will be permitted to go back to the File Locations page for another installation. If you want to process another response file, this flag must be set to True.

	
Boolean

	
No


	
NEXT_SESSION_ON_FAIL

	
Specifies whether or not you will be permitted to run another session even if the current installation has failed. This variable is active only if NEXT_SESSION is set to True.

	
Boolean

	
Yes


	
NEXT_SESSION_RESPONSE

	
Specifies the full path of the response file for the next session. If only a file name is specified, the response file is retrieved from the TEMP\OraInstall directory. This variable is active only if NEXT_SESSION is set to true.

	
String

	
No


	
ORACLE_HOME

	
Specifies the "To" location in the installer where products are to be installed. For example, "C:\OFS" (use quotation marks).

	
String

	
Yes


	
ORACLE_HOME_NAME

	
Specifies the name of the current Oracle home. For example, "OracleFailSafe" (use quotation marks).

	
String

	
Yes


	
SHOW_COMPONENT_LOCATIONS_PAGE

	
Specifies an alternative directory location for the installation. Specify False to prevent the location of the installation directory from being changed.

	
Boolean

	
No


	
SHOW_CUSTOM_TREE_PAGE

	
Specifies whether or not the custom tree page in the installer will be displayed during a custom installation, which lets you select or deselect dependencies on the custom tree page. Set the value to True if you want to show the custom tree page in the installer and allow dependencies to be selected or deselected. Specify False to suppress it.

	
Boolean

	
No


	
SHOW_END_SESSION_PAGE

	
Specifies whether or not the installation success/failure page will be displayed at the end of an installation. Set the value to True to show the page. Specify False to suppress it.

	
Boolean

	
Yes


	
SHOW_EXIT_CONFIRMATION

	
Specifies whether or not confirmation is shown when exiting the installer. Specify True to display confirmation. Specify False to suppress it.

	
Boolean

	
No


	
SHOW_INSTALL_PROGRESS_PAGE

	
Specifies whether or not the current status (including which product is being installed and which file is being copied) is displayed during the installation. Set the value to True to show the current status. Specify False to suppress it.

	
Boolean

	
No


	
SHOW_RELEASE_NOTES

	
Specifies whether or not the release notes available for the products just installed will be displayed. Set to True to show the release notes at the end of the installation. Specify False to suppress the display of the release notes.

	
Boolean

	
No


	
SHOW_REQUIRED_CONFIG_TOOL_PAGE

	
Specifies whether or not the required configuration tools that are a part of this installation, including the status of each tool and any tool failures that were detected, are displayed. Set the value to True to show the display. Specify False to suppress it.

	
Boolean

	
No


	
SHOW_ROOTSH_CONFIRMATION

	
Not applicable (NA).

	
NA

	
NA


	
SHOW_SPLASH_SCREEN

	
Specifies whether or not the splash screen for Oracle Universal Installer will be displayed. Set to true to display the initial splash screen for the Oracle Universal Installer. Set to false to suppress the display.

	
Boolean

	
No


	
SHOW_SUMMARY_PAGE

	
Specifies whether or not to display the summary page, which lists the components that will be installed in this session. Set this value to true to display the summary page. Specify false to suppress it.

	
Boolean

	
Yes


	
SHOW_WELCOME_PAGE

	
Specifies whether or not to display the welcome page. Set to true to display the welcome page. Specify false to suppress it.

	
Boolean

	
No


	
TOPLEVEL_COMPONENT

	
Specifies the name of the Oracle Fail Safe component and version as a string list. Specify the components as a pair of strings: The first one represents the internal name and the second represents the version. For example, {"oracle.failsafe.complete","3.4.2.0.0"}.

	
Stringlist

	
Yes









Table B-2  Variables for the Session Section for a Silent Mode Deinstallation

	Variable Name	Value	Type	Required?
	
DEINSTALL_LIST

	
Specifies the list of components to be deinstalled. To deinstall all Oracle Fail Safe components, specify:

{"oracle.failsafe.complete", "3.4.2.0.0"}

	
Stringlist

	
Yes


	
ORACLE_HOME

	
Specifies the location in the installer where the Oracle Fail Safe product is currently installed. For example, "C:\OFS" (use quotation marks).

	
String

	
Yes


	
ORACLE_HOME_NAME

	
Specifies the name of the current Oracle home. For example, "OracleFailSafe" (use quotation marks).

	
String

	
Yes


	
SHOW_DEINSTALL_CONFIRMATION

	
Specifies whether or not to confirm deinstallation during a deinstallation session. Set to true to confirm deinstallation. Set to false to suppress confirmation.

	
Boolean

	
No


	
SHOW_DEINSTALL_PROGRESS

	
Specifies whether or not to display deinstallation progress during a deinstallation session. Set to true to display deinstallation progress. Set to false to suppress it.

	
Boolean

	
No












B.3.3 Component Section of the Response File

The response file can contain one or more of the following Oracle Fail Safe component sections:



[oracle.failsafe.complete_3.4.2.0.0]

[oracle.failsafe.server_3.4.2.0.0]

To find a value for a variable, Oracle Universal Installer checks the appropriate component section to which the variable belongs. For an installation, all variables are required for the files in which they appear. For a deinstallaion, none of the component section variables are used.

Table B-3 describes the variables in the component section.


Table B-3  Variables for the Component Section for a Silent Mode Installation

	Variable Name	Value	Type
	
DomainUserName

	
Enter the domain and user name for an account (entered as domain\username) that has Administrator privileges. For example:


DomainUserName="OFSDomain\smith"



This variable appears in response files for Custom and Typical installations.

	
String


	
Pwd

	
Enter the password for the account you specified with the DomainUserName variable. For example:


Pwd="myadminpassword"



This variable appears in response files for Custom and Typical installations.

	
String


	
DEPENDENCY_LIST

	
Enter the dependent components that you want to install with Oracle Fail Safe. You specify the list of components using an internal name and version number. For example, the value can contain any combination of the following components:


DEPENDENCY_LIST=
"oracle.failsafe.manager","3.4.2.0.0",
{"oracle.failsafe.server","3.4.2.0.0",
"oracle.mscs.server","3.4.2.0.0",
"oracle.mscs.common:3.4.2.0.0",
"oracle.failsafe.doc:3.4.2.0.0",
"oracle.swd.oui:11.2.0.0.0"}


This variable appears in response files for only the Custom installation.

	
Stringlist


	
INSTALL_TYPE

	
Enter the internal name for only one of the following installation types:

	
The internal name for a Typical installation is Typical.


	
The internal name for a Custom installation is Custom.


	
The internal name for a Client Only installation is install_type_1.




For example: INSTALL_TYPE="install_type_1"

This variable appears in all response files.

	
String


	
OPTIONAL_CONFIG_TOOLS

	
Enter the security configuration tool to be started when you install Oracle Services for MSCS. Specify it using the internal name and external name, as follows:


OPTIONAL_CONFIG_TOOLS={"configtool1"}


This variable appears in response files only for the Typical installation.

	
Stringlist













C Manually Registering Oracle Resource DLL Files

Oracle Fail Safe provides resource dynamic-link library (DLL) files for the Oracle Database and Oracle TNS Listener. The DLL files enable the Cluster Service to communicate and manage the Oracle Database and listener resources. Other Oracle resources that do not require specialized DLL files are managed as Generic Services.

The following topics are discussed in this appendix:

	
Oracle Resource DLL Files


	
Registering and Unregistering the Oracle Database Resource DLL Files






C.1 Oracle Resource DLL Files

Oracle Services for MSCS includes the resource DLL files shown in Table C-1. These files enable MSCS to communicate with and manage the Oracle resource types.


Table C-1  Oracle Resource DLL Files

	File	Type	Description
	
FsResOdbs.dll

	
Oracle Database, Oracle TNS Listener, and Oracle resource type DLL file

	
Provides functions to allow the cluster to bring an Oracle resource online or offline and check the health of the resource through Is Alive polling. When the resource is online, the Oracle resource DLL guarantees that the resource is accessible by the client. Otherwise, the Is Alive polling fails.


	
FsResOdbsEx.dll

	
Oracle Database resource administration extension DLL file

	
Used by MSCS Cluster Administrator to display the properties of the Oracle Database resource.


	
FsResTnsLsnrEx.dll

	
Oracle TNS Listener resource extension DLL file

	
Used by MSCS Cluster Administrator to display the properties of the Oracle TNS Listener resource.








As with other cluster resources, you can apply all advanced properties of controlling the failover parameters to these Oracle resources. You can control:

	
How often MSCS should poll the Oracle resource health (Looks Alive, Is Alive polling intervals)


	
Whether a database resource should be restarted when it fails, and, if so, how many times MSCS should attempt to restart it before failing over to the other node


	
How long MSCS should wait before declaring failure of the resource (pending timeout) during the startup and shutdown of the resource

If the resource takes longer than the time you specified with the pending timeout parameter to come online or go offline and the resource DLL did not detect any problems in the online or offline process, then the resource DLL asks MSCS to give it more time to complete the process. Thus, you do not have to be concerned if a resource occasionally takes longer to come online or go offline.




	
Note:

If MSCS is unable to bring an Oracle Database resource online, or if the Is Alive polling fails, then the Oracle resource DLL logs a Microsoft Windows event under the OracleMCSServices source to indicate the reason.















C.2 Registering and Unregistering the Oracle Database Resource DLL Files

Typically, the Oracle Fail Safe Verify Cluster operation automatically verifies the Oracle Database and listener resource DLL files and their registration with the MSCS software. If the Verify Cluster operation finds that the DLL files are not registered, it registers them with the MSCS software. Using the Verify Cluster operation is the preferred method for registering DLL files.

However, if you find that the Oracle resource DLL files are not registered properly, then you can use the commands in Section C.2.1 and Section C.2.2 to manually register or unregister them.



C.2.1 Oracle Resource DLL Files

To register the Oracle Database resource DLL files, use the following commands:


fssvr /register "Oracle Database" FsResOdbs.dll

fssvr /register "Oracle TNS Listener" FsResOdbs.dll


To unregister the Oracle Database resource DLL files, use the following commands:


fssvr /unregister "Oracle Database"

fssvr /unregister "Oracle TNS Listener"







C.2.2 Oracle Resource Administrator Extension DLL Files

To register the Oracle Database resource administrator extension DLL files on the cluster nodes, use the following commands:


fsregadm /r FsResOdbsEx.dll

fsregadm /r FsResTnsLsnrEx.dll


To unregister the Oracle Database resource administrator extension DLL files on the cluster nodes, use the following commands:


fsregadm /u FsResOdbsEx.dll

fsregadm /u FsResTnsLsnrEx.dll


If MSCS Cluster Administrator is installed on a node that is not a member of a cluster, you need to register the Oracle Database resource administrator extension DLL with the cluster so that you can view Oracle Database resource parameters from the MSCS Cluster Administrator. To register, use the fsregadm command. You must issue the command from the bin directory where Oracle Fail Safe Manager is installed (because Oracle Fail Safe Manager is not in the path environment variable).

For example:


fsregadm /r /c Cluster1 FsResOdbsEx.dll

fsregadm /r /c Cluster1 FsResTnsLsnrEx.dll


You must specify the cluster name with the /c option; otherwise the command will fail.
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